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You can integrate BACnet devices into a i-Vu® or Field Assistant system using the i-Vu® XT / TruVu™ controller. 

The Carrier controller serves as a master device. 

  

Carrier   

Read/write capability Can read from and write to the third-party equipment 

Third party   

Supported equipment Any device that supports the BACnet MS/TP protocol 

Supported media IP, Ethernet, ARCNET, MS/TP (9600, 19200, 38400, 57600, 76800, 

115200) 

 

NOTE  Every media type is not supported on every controller. See the Carrier controller's <Technical Instructions>. 

 

 

 
 

Overview 



Before-you-begin checklist  
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You need the following items, information, and skills for the integration process: 

  

 The Carrier controller's Installation and Start-up Guide 

 The third party device's: 

• BACnet network number and MAC address or the Device Instance 

• Points list, including BACnet Object ID's (object type plus object instance)  

 The BACnet network’s baud rate, data bits, parity, and stop bits 

NOTE  You can set the baud rate manually or by enabling autobaud. 

 Verification that all communication settings have been set on the third party device 

 Experience creating control programs in Snap 

 Experience installing, wiring, setting up, and downloading custom control programs to the i-Vu® XT or 

TruVu™ controller 

 The latest version of Wireshark (http://www.wireshark.org) downloaded and installed. Use this network 

analysis tool for troubleshooting.    

 

 
 

Before-you-begin checklist 

http://www.wireshark.org/


 1  Connect the third-party device to the Carrier controller
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The i-Vu® XT or TruVu™ controller can reference a third-party BACnet point on any network type if a BACnet route 

to the point exists.  

You can wire a third-party BACnet device to the i-Vu® XT or TruVu™ controller's Gig-E, Eth0, or Eth1 ports, Port S1, 

or Port S2.  

NOTES   

• A non-routing controller supports BACnet devices only on the Gig-E, Eth0, or Eth1 ports and Port S1. 

• Communication may be affected by the network bandwidth as well as the frequency and number of points 

communicating. 

 

 

 

 

 

 

 

 

 

 
 

1  Connect the third-party device to the Carrier controller 



1  Connect the third-party device to the Carrier controller  
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Wiring specifications 

  

For... Use... Maximum Length 

BACnet/IP 

Ethernet 

Cat5e or higher Ethernet cable 328 feet (100 meters) 

MS/TP* 

ARCNET* 

22 AWG, low-capacitance, twisted, stranded, 

shielded copper wire * 

2000 feet (610 meters) 

* For details see the Open Controller Network Wiring Guide.    

  

 WARNING  Do not apply line voltage (mains voltage) to the controller's ports and terminals. 

 

 
 

To connect to a BACnet/IP device 

To integrate a third-party BACnet/IP device, or any device it routes to, as shown in Scenario 1: 

• Make sure an IP route to the point exists. 

• Connect an Ethernet cable to the i-Vu® XT or TruVu™ controller's Gig-E, Eth0, Eth1 Ethernet port. 

• If your controller has a rotary switch, set Port S1's rotary switch to 0 if the port is not being used for any 

network. 

  

NOTE  You must either have the Carrier IP device on the same IP subnet as the third-party device, or you must 

have BACnet Broadcast Management Devices (BBMD's) configured to communicate to the IP subnet where the 

third-party device lives. Do not configure more than one BBMD per subnet as this may cause circular routes. To 

avoid this problem: 

• i-Vu® Pro - Let SiteBuilder automatically configure your BBMD tables. (SiteBuilder defines only one controller 

per IP subnet as a BBMD.) 

• Use the BBMD Configuration Tool to make sure that a controller's BBMD table does not contain the IP 

addresses of other controllers on the same IP subnet. 

See Appendix B (page 26).  

 

 

 

 

 

 
 



 1  Connect the third-party device to the Carrier controller
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To wire to a BACnet/ARCNET network 

1 Turn off the i-Vu® XT or TruVu™ controller's power. 

2 Check the communications wiring for shorts and grounds. 

3 Connect the communications wiring to Port S1’s screw terminals labeled Net +, Net -, and Shield.  

NOTE  Use the same polarity throughout the network segment. 

4 If the controller has a Port S1 Configuration rotary switch, set it to 2. 

5 If the i-Vu® XT or TruVu™ controller is at either end of a network segment, set the port's End of Net? switch to 

Yes..  

NOTE  The controller’s End of Net switch applies network termination and bias. See the Open Controller 

Network Wiring Guide. 

6 Turn on the controller's power. 

7 To verify communication with the network, get a Module Status report in the i-Vu® or Field Assistant interface 

for a controller on the ARCNET network.  

NOTE  This step requires that you have discovered and uploaded the controller in the i-Vu® application. 

 

 
 

To wire to a BACnet MS/TP network 

The following instructions are for i-Vu® XT or TruVu™ controllers that accommodate an MS/TP network wired to 

either Port S1 or Port S2. On the non-routing controllers, an MS/TP network can be wired only to Port S1. 

 

  

1 Turn off the i-Vu® XT or TruVu™ controller's power. 

2 Check the communications wiring for shorts and grounds. 

3 Connect the communications wiring to the Port S1 or Port S2 screw terminals labeled Net +, Net -, and 

Shield.  

NOTE  Use the same polarity throughout the network segment. 

4 If you are using Port S1, and the controller has a Port S1 Configuration rotary switch, set it to 1. 

NOTE  If Port S1 is not being used for any network, set this rotary switch to 0. 

5 If the i-Vu® XT or TruVu™ controller is at either end of a network segment, set the port's End of Net? switch to 

Yes. 

NOTE  The controller’s End of Net switch applies network termination and bias. See the Open Controller 

Network Wiring Guide. 

6 Turn on the controller's power. 

7 To verify communication with the network, get a Module Status report in the i-Vu® or Field Assistant interface 

for a controller on the MS/TP network.  

NOTE  This step requires that you have discovered and uploaded the controller in the i-Vu® application. 

 

 
 



2  Discover BACnet networks, devices, and objects  
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The i-Vu® or Field Assistant BACnet Discovery feature locates all accessible BACnet networks, BACnet devices, 

and BACnet objects (including devices in your i-Vu® Plus or Pro or Field Assistant system) on a BACnet network.  

NOTE  BACnet Discovery is not available in the i-Vu® Standard application. 

 

To use BACnet Discovery: 

1 Select the System  in the navigation tree and then the Devices page > Advanced tab.  

2 Click the BACnet Discovery Start button to discover BACnet networks for the sites. An item called Discovered 

Networks appears in the tree.  

3 To discover BACnet networks, select Discovered Networks, then click Go. A list of all BACnet networks 

appears in the navigation tree. After all networks are found, close the status dialog box. 

 TIP  Run a commstat manual command to determine which device routes to each network. The BACnet 

Bind Show Network section of the Commstat window shows the IP address of the router to each network.   

4 To discover BACnet devices on a network, select a network in the navigation tree, then click Go. After all 

devices are found, close the status dialog box. Click  beside an item to expand the list of devices.  

5 To discover BACnet objects on a device, select the device on the navigation tree, then click Go. After all 

objects are found, close the status dialog box. A list of all BACnet objects in this device appears on the 

navigation tree.  

 TIP  Make sure you are discovering objects in the correct device. It may take some time to discover 

objects in devices with more than 100 objects. 

6 Optional:  Do the following to export the BACnet information so that it can be used in the Snap application: 

a) On the navigation tree, select a discovered network with devices or a single device. 

b) Click Export. 

c) Name and save the .discovery file in any folder. 

 

NOTES 

• Some third-party BACnet devices may not be discovered because they do not support the BACnet methods 

required for auto discovery. 

• If the discovery process returns ambiguous information, such as multiple points with similar names, contact 

the third-party manufacturer's representative for clarification. 

• Device configuration or network load can prevent the i-Vu® or Field Assistant interface from showing all 

BACnet devices. If you do not see a BACnet device that you expect to see, check the system's BBMD 

configurations. If the configurations are correct, try the discovery process again. 

• If a third-party device is not discoverable, you must get the device's address and point list information from 

the third-party vendor. See To format a BACnet address. 

• Troubleshooting BBMD's. See Appendix B - Setting up BBMDs (page 26) or the BBMD Utility User Guide. 

 

 
 

2  Discover BACnet networks, devices, and objects 



 3  Create a control program in Snap
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Use Network I/O microblocks and Display microblocks to read from or write to BACnet objects in a third-party 

BACnet device.  

Use Network I/O microblocks if any of the following is true: 

• An Carrier control program must read from or write to third-party BACnet points for automatic control. 

• You want to trend values from a third-party device that does not support BACnet trends. 

• You want to display third-party values that require unit conversion or other math processing. 

 

Use Network I/O microblocks if any of the following is true: 

• A Carrier control program must read from or write to third-party BACnet points for automatic control. 

• You want to trend values from a third-party device that does not support BACnet trends. 

• You want to display third-party values that require unit conversion or other math processing. 

 

 TIP  Verify the third-party manufacturer’s addressing pattern by establishing communication with a few points 

whose values you can physically manipulate before you spend time addressing the remaining integration points.  

???NOTE  You can use the Check All and Uncheck All buttons to the far right. 

To create a control program   

1 Go to Start > All Programs > i-Vu Tools x.x > Snap. 

2 Select the appropriate Network Input and Output or Display microblocks to use to gather data from third-party 

device.  

3 Use a unique name and save the .equipment file to any folder. 

4 In Snap, select Edit > Third Party BACnet Addresses.   

5 Browse to the .discovery file that you saved from the i-Vu® or Field Assistant BACnet Discovery tool. 

6 Click on one of the Network Input and Output or Display microblocks. 

NOTE  Check Only show objects that match selected microblock to display only the applicable third party 

points. 

7 Select one of the points from Third Party Addresses. 

8 Click Set Address to place the third party address into the selected microblock. 

9 Save the file. 

 

 

 

 

 

 

3  Create a control program in Snap 



3  Create a control program in Snap  
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To create a control program for multiple identical third-party devices 

If you are integrating to multiple identical third-party devices, the i-Vu® or Field Assistant application can help you 

address the Network I/O microblocks. 

1 Replicate the first device's control program for each of the other third-party devices. 

2 Do one of the following: 

• If Network I/O microblocks were addressed in the Snap application, go to step 3. 

• If the Network I/O microblocks do not have addresses, enter the addresses in the i-Vu® or Field 

Assistant interface for one instance of the equipment. Do this on the equipment's Properties page > 

Network Points tab. Then use Global Copy to copy the addresses to all other instances of the equipment. 

3 Go to the Properties page > Network Points tab for another instance of the equipment. 

4 Click Search/Replace at the top of the Address column. 

5 Replace the device identification in the addresses with the identification for the third-party device the control 

program will communicate with. 

 

 
 

To edit a microblock address 

You can edit a microblock address in the following places: 

• In the Snap Property Editor  

• In the i-Vu® or Field Assistant interface on the microblock's Properties page > Details tab 

• In the i-Vu® or Field Assistant interface on the control program's Properties page > Network Points tab  

 

 
 

To format a BACnet address 

The BACnet standard allows multiple formats for creating a valid address in each microblock that you use to read 

from or write to a third-party BACnet point. Some are shown below. 

 CAUTION  When integrating third-party devices into your system, most communication problems are caused 

by incorrect data or typing errors in the microblock's Address field. 

  

 

  

NOTE  Numeric values in a BACnet address can be entered using decimal or hexadecimal notation. Type 0x 

before a hexadecimal value. 

  

  

 

 



 3  Create a control program in Snap
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Device - Use one of the following: EXAMPLES 

 Device instance number 

  

bacnet://2010/… 

 BACnet device name 

  

bacnet://MyDevice/… 

 Network number: MAC address        

(of third-party device) 

  

bacnet://1234:35/… 

bacnet://1234:0x23/… 

 The word "this" if a network point requests a value from 

another control program in the same Carrier controller. Avoids 

network traffic. Requires v2.05 or later controller driver. 

  

bacnet://this/… 

 A single * (wildcard) that sends out a  request on the network 

for all devices that contain the Object specified in the address. 

(See Object below.) The microblock subscribes to the nearest 

responder. 

NOTES   

• You can use an * in the  address of Network Input  

microblock.  

• An address with an * is restricted to the present_value 

property (the default when you do not specify a property). 

bacnet://*/… 

 

  

 
Object - Use one of the following: EXAMPLES 

 Object type: Instance number 

(See NOTES below) 

 

BACnet object name 

bacnet://…/ai:2 

  

  

bacnet://…/MyObject 

  

NOTES 

• For object type, you may type the abbreviation (not case sensitive), the full name, or the object type 

number. Some standard BACnet object type numbers are listed below. See the BACnet standard for a 

complete list.  For proprietary BACnet objects, see the object's manufacturer. 

 Use... 

ai 

ao 

av 

bi 

bo 

bv 

dev 

msi 

mso 

msv 

Or... 

analog-input 

analog-output 

analog-value 

binary-input 

binary-output 

binary-value 

device 

multistate-input 

multistate-output 

multistate-value 

Or... 

0 

1 

2 

3 

4 

5 

8 

13 

14 

19 

 • Every object in a controller has a unique instance number, regardless of its control program. 

 

  



3  Create a control program in Snap  
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Property (optional)  If you want to read or write a property other 

than present_value, type one of the following: 

EXAMPLES 

 BACnet property identifier 

 

BACnet property identifier # 

 

Property identifier (with index) 

bacnet://…/…/cov_increment 

 
bacnet://…/…/22 

 
bacnet://…/…/priority-

array(12) 

 Property identifier # (with index) bacnet://…/…/87(12) 

 NOTE  Some standard BACnet properties are listed below. See the BACnet standard for a complete list. For 

proprietary BACnet objects, see the object's manufacturer. 

 Property identifier 

change_of_state_count 

cov_increment 

derivative_constant 

event_state 

high_limit 

integral_constant 

low_limit 

max_pres_value 

min_pres_value 

out-of-service 

present_value 

proportional_constant 

reliability 

relinquish_default 

setpoint 

system_status 

trigger 

units 

vendor_identifier 

Identifier # 

15 

22 

26 

36 

45 

49 

59 

65 

69 

81 

85 

93 

103 

104 

108 

112 

205 

117 

120 

 

  

 
Priority (optional)  If you want to write at a priority other than 

16, type @ followed by a priority number. 

EXAMPLE 

 Number  (1–16) bacnet://…/…/…@9 

 NOTE  Priority levels 1 and 2 are reserved for manual and automatic life safety commands. For more 

information on reserved priority levels see the BACnet standard. 

 

 

Examples of BACnet addresses: 

bacnet://MyDevice/ai:2 

bacnet://1234:0x23/analog-input:2/priority-array(12)@8 

bacnet://2499:0x00E0C90047CA/bi:3 

bacnet://2436:192.168.47.36:47806/0:2 

 
 



 3  Create a control program in Snap
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To set up network inputs 

Polling or BACnet COV 

If a network input or totalizer microblock's Address field references a BACnet object property, the microblock 

reads the property's value using one of the following methods. 

• Polling—The microblock reads the property at the Refresh Time interval using the BACnet ReadProperty or 

ReadPropertyMultiple service (see "Method 1: Polling" below). 

• BACnet COV (Change of Value) subscription—The microblock subscribes with the target BACnet object. An 

analog target notifies the microblock if the target's value changes by more than the target's BACnet 

COV_Increment. A binary target notifies the microblock when it changes state (see "Method 2: BACnet COV 

subscriptions" below). 

  

Method 1:   Polling  

Benefits • Allows rapid detection of a dead device or of network problems 

• Does not require additional memory 

Drawbacks • Generates unnecessary network traffic if a value does not change frequently 

• Misses value changes that occur between pollings 

• Can overwhelm the target's controller if many microblocks request the same property 

value (such as outside air temperature). The BACnet object must send the value to each 

microblock that polls for that data. 

To set up Set the microblock's Refresh Time to 30 seconds or less. 

  

NOTE  The microblock will not poll at a Refresh Time interval smaller than 1 second. 

  

  

BACnet ReadProperty and ReadPropertyMultiple services 

See the BACnet specification for details on the ReadProperty and ReadPropertyMultiple services. 

ReadPropertyMultiple occurs if: 

• two or more microblocks in a controller read more than one target in the same remote controller,  

• the Refresh Time in two or more microblocks expires at the same time, and  

• the remote controller supports the service. 

  

Method 2:   BACnet COV subscriptions  

Benefits • Can decrease network traffic by preventing unnecessary updates if the target's 

COV_Increment is set appropriately. See step 2 in "To set up" below.  

Drawbacks • Can generate excessive network traffic if the target's COV_Increment property is too 

small. See step 2 in "To set up" below. 

• Can delay detection of a dead device or of network problems 

To set up 1 Set the microblock's Refresh Time to 31 seconds or more. 

2 If the microblock's Address field references an analog property, set the target's 

COV_Increment property to the smallest amount by which the value must change for the 

target to notify its subscribers. The optimal COV_Increment is large enough to prevent 

unnecessary updates but small enough to be useful to the control program(s) receiving 

the updates. 

NOTE  If COV subscription fails, the microblock reads the value at the Refresh Time interval using the BACnet 

ReadProperty or ReadPropertyMultiple service. See "Method 1: Polling" above. 



3  Create a control program in Snap  
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COV subscription details  

When an input (network input or totalizer microblock) subscribes with a BACnet target (object property), the input 

sets a 21-minute subscription Lifetime in the target. The target responds with a COV notification that includes the 

target's value and time remaining from the original subscription Lifetime (TimeRemaining). The input resubscribes 

with the target every 10 minutes to keep the target's BACnet subscription service active. i-Vu® or Field Assistant 

shows the time remaining until the input's next subscription in the Next Refresh field on the input's i-Vu® or Field 

Assistant Properties page. 

The target also sends a COV notification that includes the target's value and subscription Lifetime TimeRemaining 

when the target's value changes by more than the target's COV_Increment.  

If the Carrier target has one subscriber, the target sends COV notifications directly to that subscriber.  If the Carrier 

target has more than one subscriber, it broadcasts its COV notifications to optimize network traffic. A third-party 

subscriber can participate in this broadcast scheme by subscribing for Unconfirmed COV notifications with a 

Process ID of 0. Otherwise, the Carrier target maintains and responds to the third-party subscription separately 

with its own Lifetime timer. 

The Carrier input compares the TimeRemaining value in each COV notification broadcast the target sends to its 

(Next Subscription time + 11) to determine whether another input has subscribed since it did. If another input has 

subscribed more recently, the input adds 10 minutes to its Next Refresh time. This allows the COV Subscription 

request from the last subscribing input to keep the subscription service active for all subscribers to the same 

data. 

EXAMPLE 

Elapsed 

time 

(minutes) 

Action Target  

Lifetime 

TimeRemaining 

(minutes) 

Input 1  

Next Subscription 

(minutes) 

Input 2  

Next Subscription 

(minutes) 

0 Input 1 subscribes to target 21 (Input 1) 10   

0 Target broadcasts COV notification 

because Input 1 subscribed 

21 21 ≤ 10 + 11, 

so keep current 

value of 10 

  

2 Input 2 subscribes to target 21 (Input 2) 10 - 2 = 8 10 

0 Target broadcasts COV notification 

because Input 2 subscribed 

21 21 > 8 + 11, 

so add 10 to 

current value of 8 

8 + 10 = 18 

21 ≤ 10 + 11, 

so keep current 

value of 10 

3   21 - 3 = 18 18 - 3 = 15 10 - 3 = 7 

0 Target broadcasts COV notification 

because value changed 

18 18 ≤ 15 + 11 

so keep current 

value of 15 

18 ≤ 7 + 11 

so keep current 

value of 7 

7   18 - 7 = 11 15 - 7 = 8 7 - 7 = 0 

resubscribe 

0 Input 2 resubscribes 21 (Input 2) 8 10 

0 Target broadcasts COV notification 

because Input 2 subscribed 

21 21 > 8 + 11, 

so add 10 to 

current value 

8 + 10 = 18 

21 ≤ 10 + 11, 

so keep current 

value of 10 

Input 2 keeps the subscription service active at the target with a minimum of network traffic.  

NOTE  If an input receives COV notification with a target TimeRemaining < 11, which could happen if the last 

subscribing input loses communication with the target, the input resubscribes immediately. 



 3  Create a control program in Snap

  

 

 

 
BACnet Integration Guide  CARRIER CORPORATION ©2022   

for i-Vu® XT or TruVu™ controllers  All rights reserved 

 13 

 

COV notification rate 

COV notifications from a BACnet object property are controlled by that property's BACnet COV_Increment.  When 

the absolute value of the difference between the property's Present_Value and the value sent in the last COV 

notification is greater than the COV_Increment, the object broadcasts a COV notification. For Carrier controllers, 

the rate of notifications is further limited by two internal processes.  

1 The control program's execution rate determines how often the check against COV_Increment is performed. 

2 The controller's pending COV Notification task has built-in delays to prevent COV notifications from consuming 

the controller's CPU processing time. 

The built-in delays are as follows: 

If more than 15 COV notifications are pending delivery, the controller inserts a 50 millisecond delay after 

each set of 15 notifications.  Once the entire list of pending notifications is serviced, the controller inserts 

another 50 millisecond delay. This results in a maximum COV notification rate of 300 COV notifications per 

second per Carrier controller. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 



3  Create a control program in Snap  
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To speed detection of a dead device 

If a BACnet object's device loses network communication, a network input reading the object's value does not 

detect the failure until: 

• The network input's next subscription (up to 10 minutes) if using BACnet COV subscription, or 

• The Refresh Time expires, if polling 

You can use a small Refresh Time to poll more often, but this can generate unnecessary network traffic under 

normal conditions.  

To use the benefits of BACnet COV subscription, but overcome the potential delay in detection of a dead device, 

send a constantly changing value from the BACnet object's control program to a network input using BACnet COV 

subscription. If the value stops changing, the network input's control program generates an alarm. 

  

EXAMPLE 

The logic in the BACnet object's control program that sends the value. The BACnet Analog Value microblock has a 

COV Increment of 0.5. 

 
 

The logic in the network input's control program that receives the changing value. The SIGNAL analog network 

input's Address field contains the address of the BACnet Analog Value microblock sending the changing signal, 

and the network input's Refresh Time is 31 seconds. 

 

 

 
 



 4  Configure Display microblocks
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To allow an operator to change a third-party object's property from the i-Vu® or Field Assistant interface through a 

Display microblock, the desired property must be present and be editable (not marked "Read only") in the third-

party object. 

In the Snap Property Editor of a microblock, select Present (if the optional property exists in the third-party device), 

Editable, and Write to field checkboxes. See COV increment in the example below. 

 

  

The Display microblocks in the table below require special configuration. 

  

Binary Output 

Binary Value 

If you want the text of a BACnet Modeled Binary Output or BACnet Modeled Binary Value on a 

graphic to display the inactive and active text instead of 0 and 1, select the Present 

checkboxes. 

 

NOTE  If the third-party device does not support this feature, your graphic will display 0 or 1 

even if you select the Present checkboxes. 

Schedule If you want the i-Vu® or Field Assistant schedule to write to a third-party BACnet-schedule 

object through a BACnet modeled schedule object, do the following:  

1 In the Snap application, select the Schedule Category of the i-Vu® or Field Assistant 

schedule that will write to the third-party object. 

2 In the Property Editor, select the Present, Editable, and Write to field checkboxes for 

Weekly Schedule and Exception Schedule.  

 

NOTES 

• Only Carrier-manufactured devices support Carrier Dated Weekly schedules. 

• If you get an error in the i-Vu® or Field Assistant interface, clear the Array Resize Write 

Index and Array Resize Write Past End checkboxes. 

4  Configure Display microblocks 



4  Configure Display microblocks  
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Event 

Notification 

You can use a BACnet Modeled Event Enrollment microblock to view the status of a third-party 

BACnet Event Object. If you want the third-party device to deliver its alarms to the i-Vu® or Field 

Assistant Alarms View tab, you must configure the third-party device to send alarms to the i-

Vu® or Field Assistant Server application. You can add i-Vu® or Field Assistant Server to the 

Recipient List for each alarm or set up a BACnet Modeled Notification Class microblock to add 

i-Vu® or Field Assistant Server to the Recipient List for every alarm generated by the third-party 

device.  

NOTE  A third-party device may not retain alarm recipient information through a power loss or 

download. 

1 In the BACnet Modeled Event Enrollment microblock, select the Standard Template for the 

best results on your i-Vu® or Field Assistant Alarms View tab. 

2 In the Event Enrollment or Notification Class microblock, select the  Editable and Write to 

field checkboxes for Recipient List. 

 
  

3 On the i-Vu® or Field Assistant Properties page Details tab for a device's BACnet Modeled 

Notification Class microblock or an event's BACnet Modeled Event Enrollment microblock, 

click Add. 

4 Define the recipient. See field descriptions below. 

5 Generate an alarm at the third-party device to verify that you see the alarm delivered to 

your i-Vu® or Field Assistant Alarms View tab. 

  

  Field Notes 

  Recipient Type Select Device. 

  Time section Select the days and define the hours that the third-party 

device should send alarms to i-Vu® or Field Assistant 

Server. 

  Device Object Identifier Enter your i-Vu® or Field Assistant system's BACnet 

Alarm Recipient instance number. 

  Process Identifier Type 1. 

  Issue Confirmed Notification Select this checkbox. 

Trend If the third-party trend does not display correctly, change the Trend Conformance Level to 

Default. 

 

 
 



 5  Download the driver and control programs
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If you need an updated drv_fwex driver or the latest SAL library, go to Carrier Control Systems Support Sites 

http://www.hvacpartners.com/, https://accounts.ivusystems.com/ and save it to your computer.  

 

To change the driver 

1 On the i-Vu® or Field Assistant navigation tree, right-click the controller that you wish to update and select 

Driver Properties.  

2 Go to Driver > Properties > Update tab.  

3 Do one of the following: 

  

If the driver is...  

In the Driver Version drop-down list a.  Select the driver. 

b.  Click Accept. 

Not in the Driver Version drop-down list Click Update and the driver is updated using the latest 

Factory SAL. 

or 

a) Click Add. 

b) Browse to select the driver. 

c) c.  Click Open. 

d) d.  Click Continue. 

e) e.  Click Close. 

f) f.  Click Close again. 

 

4 Click the Download All Content button. 

5 Click OK.  

6 Click Accept. 

  

 

 

 

 

 

 

 

 

5  Download the driver and control programs 

http://www.hvacpartners.com/
https://accounts.ivusystems.com/


5  Download the driver and control programs  
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To update the SAL library in the i-Vu® application 

1  In the i-Vu® interface, click System Menu , then select System Options > Update. 

NOTE  Expand Current Libraries (.sal) to see the current SAL libraries and their revision. Compare them to 

what you downloaded and determine if any of them need updating. 

2 Click  and browse to the updated .sal file that you have saved on your computer, select the 

file, and click Open. 

3 Click Continue. 

4 When process is complete, the message appears File added successfully. 

5 Click Close. 

6 Click Close again. 

7 Click the Download All Content button. 

8 Click OK.  

9 Click Accept. 

 

To add a control program 

1 Select the router in the navigation tree and go to the Devices > Manage tab. 

2 If you are adding a new control program, click the Add Control Program button . A dialog 

window appears. 

3 Enter a name for your control program in Display Name and select your controller in the Controller drop-down 

list. 

4 Do one of the following: 

  

If the control program is...  

In the Control Program drop-down list Select the control program. 

Not in the Control Program drop-down list a.  Click Add New. 

b.  Browse to select the control program. 

c.  Click Open. 

d.  Click Continue. 

e.  Click Close. 

 

5 Click Continue. When message appears File added successfully, click Close. 

6 Click Close again. 

7 Right-click on the controller in the list and select Check Status from the list. The status of the controller 

should say File Mismatch. 

8 Click the Download All Content button.  

 

 
 



 6  Verify the network points are operating correctly

  

 

 

 
BACnet Integration Guide  CARRIER CORPORATION ©2022   

for i-Vu® XT or TruVu™ controllers  All rights reserved 

 19 

 

1 On the i-Vu® or Field Assistant navigation tree, select the Carrier controller. 

2 Select the Properties page > Network Points tab. 

 

If... Then... 

You see the point value you 

expect with no errors in the Error 

column 

You have successfully established communication with the 

third-party device. 

All points show question marks 

instead of values 

The i-Vu® or Field Assistant application is not communicating 

with the i-Vu® XT or TruVu™ controller. Troubleshoot 

communications. See the Carrier controller's Installation and 

Start-up Guide. 

The point name is red Look in the Error column for one of the following error codes 

and descriptions. 

• 1 - Communications Disabled for this Microblock 

Enable the integration point's Communications Enabled 

field on the i-Vu® or Field Assistant Network Points tab. 

• 3 - Address Error - Unknown Protocol Specified 

Verify that Address in the integration point is correct.  

A value is incorrect  Verify that: 

• The Address in the integration point is correct.  

• The retrieved value is scaled properly, if necessary. For 

example, scaled from Celsius to Fahrenheit. Refer to the 

third-party manufacturer's documentation for scaling 

information. 

If the above solutions do not resolve the problem, gather the following information for Technical Support: 

• A diagnostic capture. See next topic. 

• A screenshot of the Driver Properties - right-click on the third-party controller in the navigation tree, select 

Driver Properties > Properties page > BACnet MS/TP > Properties page 

• A screenshot of the controller's Properties page > Network Points tab, showing addresses and errors 

 

 

 

 

 

 

 

 
 

6  Verify the network points are operating correctly 



6  Verify the network points are operating correctly  
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Network Diagnostics - Packet Capture 

This page allows you to capture network communication on a port and then download the capture file for 

troubleshooting. Choose one of the following capture options: 

• Start/Stop - Define the start and stop criteria, and then click Start and Accept to begin the capture. When the 

capture stops, the capture file is generated. 

NOTE  If a Start/Stop capture is running on any other port, the Get capture file button will be disabled until all 

Start/Stop captures have completed. 

○ Start capture: - When you check At (mm/dd/yyyy hh:mm AM/PM), enter the time and date, and click 

Start, the packet capture begins at the date and time you specified.  

NOTE  The hours field is validated from 0 to 12, and minute field is validated from 0 to 59. 

○ Continuous - Click Start and Accept to begin the capture. Click Save to momentarily stop the capture and 

create the capture file. The capture will automatically resume. Click on the Start/Stop option to end the 

Continuous capture. 

○ If the port is set up for MS/TP, select an option in the Capture section. 
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To download the capture file 

Capture files are Wireshark files that are added to the Device Log Archive .tgz file. Do the following to view the 

files.  

1 If you do not have Wireshark installed on your computer, download the latest version from the Wireshark 

website (http://www.wireshark.org).  

2 Run the install program, accepting all defaults. Include WinPcap in the installation. 

3 On the i-Vu® or Field Assistant Packet Capture page, click Get capture file to download the .tgz file. The 

message appears "Retrieving the file, this may take a little while". Click OK. 

NOTE  If the size of the .tgz is large, there could be a considerable delay (for example, over 2 minutes) after 

you click Get capture file until your browser begins the download.  

4 Open the .tgz file. The files are in the captures folder.  

 

Capture file names are based on the ports.  

NOTES   

• If you have an MSTP capture file for both Port S1 and Port S2, the file names will be: 

mstpcap0 for Port S1 

mstpcap1 for Port S2 

• Clicking Get capture file generates the port's .pcap file. If the port has a .pcap file from a previous 

capture, that file will be overwritten. 

  

5 Extract the .pcap file from the .tgz file. 

6 Open the .pcap file in Wireshark. 

 

 
 

http://www.wireshark.org/
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You can set many driver parameters locally from the controller by using the Service Port's web-based controller 

setup interface. You can set operational parameters, such as port and communications' protocol settings, without 

the need to connect the i-Vu® or Field Assistant application to the i-Vu® XT or TruVu™ controller. Any parameters 

set locally through this interface take effect immediately. To connect to the controller setup pages, some i-Vu® XT 

or TruVu™ controllers have an Ethernet Service Port and some have a USB Service Port. 

  WARNING  After setting parameters locally through the Service Port interface and then connecting the 

controller to the i-Vu® or Field Assistant application, proceed carefully, as follows: 

In the i-Vu® or Field Assistant application, you must upload the parameters that you set locally BEFORE you 

download memory or parameters. Downloading, without uploading first, overwrites all the settings you made 

through the Service Port. Uploading first preserves those parameters.  

NOTE  There are a few parameters that can only be set through the Service Port, such as the controller’s IP 

address, and these are not overwritten by a memory or parameter download from the i-Vu® or Field Assistant 

application. 

 

To connect to the Service Port: 

1 Make sure your computer is set to get its IPv4 address automatically via DHCP. 

2 Connect an Ethernet cable from a computer to the controller as shown below. 

 

 
  

3 Turn off the computer's Wi-Fi if it is on. 

4 If your computer uses a static IP address, use the following settings: 

○ Address: 169.254.1.x, where x is 2 to 7 

○ Subnet Mask: 255.255.255.248 

○ Default Gateway: 169.254.1.1  

5  If it uses a DHCP address, leave the address as it is. 

6 Open a web browser on the computer.  

7 Navigate to http://local.access or http://169.254.1.1 to see the Service Port controller setup pages. 

 CAUTION  Do not connect the Service Port to the same network that the Gig-E port is connected to. The 

Service Port is intended for single computer access only and has a fixed IP address that is not compatible 

with a building network. 

Appendix A - Configuring the driver parameters by using the Service Port 
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The BACnet tab for all routing controllers 

 

IP Port  

BACnet Network Number Disable Routing—Select if the IP port is not used. 

Autogenerated—The BACnet/IP network number is automatically set to 00. 

Assigned—Lets you enter a specific number. 

BACnet UDP Port The port that the i-Vu® or Field Assistant application will use for BACnet 

communication. 

Enable NAT Routing For future use.  

Check if the i-Vu® XT or TruVu™ controller is behind a NAT router (firewall). 

Global NAT IP Address For future use.  

Public IP address of the NAT router. 

Global NAT BACnet UDP Port For future use. 

Port number assigned to the NAT router's public interface. 

BACnet Secondary IP Net 

Number 

If the i-Vu® XT or TruVu™ controller has two BACnet/IP networks communicating 

on the Gig-E port, enter the second IP network number in this field. 

If the i-Vu® XT or TruVu™ controller is behind a NAT router and there is a second 

network with BACnet/IP devices behind the NAT router, enter the second network 

number in this field to logically connect the i-Vu® XT or TruVu™ controller to the 

devices on the second network.  

P rivate

s ide

BACnet

router
Public

s ideN

A
T

R

Controller
Secondary IP

network

C

 

BACnet Secondary UDP Port If the i-Vu® XT or TruVu™ controller has two BACnet/IP networks communicating 

on the Gig-E port, enter the port number that the i-Vu® or Field Assistant 

application will use for BACnet communication. This port must be different than 

the BACnet UDP Port. 

Ethernet Port  

MAC Address A factory assigned Ethernet MAC Address for the Gig-E port. 

BACnet Network Number Specify a number for the BACnet/Ethernet network or set to 0 if the port is not 

used. 

Port S1  

End of Network Indicates status of the controller's End of Net? switch. 

Active Protocol Indicates status of the controller's Port S1 rotary switch.   

0=Disabled 

1=MS/TP 

2=ARCNET 

3=Modbus 

MAC Address When using ARCNET, the default is 254, and MSTP is 0. These addresses are 

hard coded and you cannot change them. 

MSTP Autobaud Select Yes to enable this slave device to automatically receive its baud rate from a 

master on the network that has the fixed baud rate.  
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MSTP Baud Rate If you have not enabled autobaud, set this to a baud rate that all other devices on 

the MS/TP network are set to. Default is 76800. 

MSTP Max Master To increase MS/TP performance, enter the highest address used on the MS/TP 

network for a master controller. This number must be less than or equal to 127. 

MSTP Max Info Frames This is the maximum number of information messages a controller may transmit 

before it must pass the token to the next controller. Valid values are 1 to 255. 

 TIP  Set Max Info Frames to a number in the range 20 to 100 so that the 

router does not become a bottleneck for traffic being routed from a high-speed 

network to the slower MS/TP network. 

BACnet Network Number Select: 

Disable Routing if Port S1 is not used. 

Autogenerated to have the network number for Port S1 automatically set to a 

number equal to ((IP network number + rotary switch address) x 10). 

Assigned to enter a specific number. 

Port S2  

End of Network Indicates status of the controller's End of Net? switch. 

Active Protocol Shows one of the following: 

• Modbus if enabled on the Modbus tab 

• BACnet/MSTP if you enter a BACnet Network Number below for an MS/TP 

network 

• Disabled if neither of the above have been done 

MSTP Address The controller’s unique address on the MS/TP network. Default is 0. 

MSTP Autobaud Select Yes to enable this slave device to automatically receive its baud rate from 

a master on the network that has the fixed baud rate.  

MSTP Baud Rate If yoiu have not enabled autobaud, set this to a baud rate that all other devices on 

the MS/TP network are set to.  

MSTP Max Master To increase MS/TP performance, enter the highest address used on the MS/TP 

network for a master controller. This number must be less than or equal to 127. 

MSTP Max Info Frames This is the maximum number of information messages a controller may transmit 

before it must pass the token to the next controller. Valid values are 1 to 255. 

 TIP  You can set Max Info Frames so that the router does not become a 

bottleneck for traffic being routed from a high speed network to the slower MS/TP 

network.  

BACnet Network Number Select: 

Disable Routing if Port S2 is not used. 

Autogenerated to have the network number for Port S2 automatically set to a 

number equal to ((IP network number + rotary switch address) x 10) + 3. 

Assigned to enter a specific number. 

Home Network This is typically the network that is communicating with the building automation 

system's application. This sets the BACnet Address of the Device object. 
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The BACnet tab for non-routing controllers  

NOTE  The i-Vu® XT or TruVu™ can be configured for only one BACnet communication type. 

On the BACnet tab, you can: 

• Choose to run BACnet Over IP or BACnet Over Ethernet on the Gig-E Port. 

If you choose BACnet Over IP, you can edit the BACnet UDP Port. 

NOTE  The Port S1 Configuration rotary switch must be set to 0, 3, or 4 for these options to be editable. 

• The Port S1 Configuration rotary switch must be set to 1 for MSTP or 2 for ARCNET. 

• Enable or disable MSTP Autobaud on Port S1. This device will receive its baud rate from the master device 

with the fixed baud rate. 

• Set MS/TP Baud Rate to a baud rate that all other devices on the MS/TP network are set to. 
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To minimize network communications, IP routers do not pass on broadcasts that they receive. If your system has 

controllers on different IP subnets separated by an IP router, you must set up a BACnet router on each IP subnet 

as a BACnet Broadcast Management Device (BBMD). A BBMD passes BACnet/IP broadcasts across the IP router 

to other BBMDs.  

 

IP subnet
R

BBMD

172.18.1.1 172.16.1.1

IP Router

Controller Controller

IP subnet

BBMD

 

   

 NOTES 

• The i-Vu® Standard or Plus application - If the i-Vu® web server is on a separate subnet than the rest of the 

routers, the internal router must be assigned an IP address and configured as a BBMD. 

• The i-Vu® Pro application - If the i-Vu® Pro server is on a separate subnet than the rest of the routers, you 

must register it as a foreign device.  

 

 

To set up BBMDs, use the appropriate method in the table below. 

 

If your i-Vu® or Field Assistant system has... Use this method 

500 or less IP subnets with: 

• No third-party BACnet routers 

• Authority from your customer to manage all Carrier and 

third-party BBMDs on the network 

• Third-party BACnet routers that support BBMD writes from 

the network 

• The i-Vu® Standard or Plus application - 

Set up BBMDs through the i-Vu® 

interface, or using the BBMD 

Configuration Tool. 

• The i-Vu® Pro application - Let SiteBuilder 

automatically configure your BBMDs. 

Any of the following: 

• More than 500 IP subnets  

• Third-party BBMDs that you do not have authority to 

manage 

• Third-party BBMDs that use a non-standard port for BACnet 

communications 

Set up custom BBMDs in the i-Vu® or Field 

Assistant interface or in the BBMD 

Configuration Tool. 
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There are multiple ways for configuring BBMD’s in an i-Vu system 

1 In thei-Vu® or Field Assistant navigation tree, select the Carrier router that will be the BBMD. 

2 To check if that router has an existing BBMD table, click , select Manual Command, and type bbmd 

read.  

NOTE  If you want to read the BBMD table for a different router, select it and perform a Manual Command 

bbmd read x.x.x.x where x.x.x.x is the IP address of the controller you are on. 

3 Click OK. 

4 Make a list of the IP addresses for every router that will function as a BBMD in your system. 

  

  CAUTION  Multiple BBMDs on an IP subnet disrupt BACnet communications. Define only one BBMD on 

either side of each IP router in your system. 
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To set up BBMDs in SiteBuilder 

As you add each Carrier BACnet router to an IP network on the Network tree, check Automatically Configure My 

BBMDs on the Address tab. SiteBuilder automatically selects a router in each IP subnet as the BBMD and sets up 

BBMD tables appropriately. 

To see which BACnet routers SiteBuilder assigned as BBMDs, select View > Display > BBMD. BBMDs show 

B=assigned on the Network tree. 

To override SiteBuilder's BBMD selection, right-click a different BACnet router on the same IP subnet, then select 

Force to BBMD.  

  

NOTE  If you are managing 3rd party BBMDs, you must add every 3rd party device that could be a BBMD as a 3rd 

party device router in SiteBuilder. 

 

 
 

To create and download a BBMD table 

 

1 Make a list of the IP addresses for every controller that will function as a BBMD in your system. 

 CAUTION  Multiple BBMDs on an IP subnet disrupt BACnet communications. Define only one BBMD on 

either side of each IP router in your system. 

2 In Notepad, type the list putting each IP address on a separate line. (i-Vu® XT or TruVu™ routers support up 

to 500.) 

NOTE  If you must communicate with a third-party router that does not use the BACnet/IP port 47808 

(0xbac0), you must include the hexadecimal port number in the IP address. For example, 
172.168.23.67:0xe78a 

 

 

3 Save the file to your folder of choice or the webroot\<system_name> folder. Use a .bdt, .bbmd, or .text 

extension instead of .txt.   

4 On the i-Vu® or Field Assistant navigation tree, select one of the Carrier controllers that will function as a 

BBMD. 
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5 To check if the controller has an existing BBMD table, click  and select Manual Command. 

6 In the manual command field, type:  bbmd read x.x.x.x 

where x.x.x.x is the IP address of the controller you are on. 

7 Click OK. 

8 If the Broadcast Distribution Table contains IP addresses that are not in your file, add them to your file. 

9  Click  and select Manual Command. 

10 In the manual command field, type:  bbmd write filename.ext x.x.x.x 

where filename.ext is the .bdt, .bbmd, or .text file in the webroot\<system_name> folder 

and x.x.x.x is the IP address of the controller you are on. 

11 If the Broadcast Distribution Table contains IP addresses that are not in your file, verify that they are valid 

BBMD's and, if so, add them to your file.  

12 Click OK. 

13 Issue another bbmd read command to verify that the file was written correctly. 
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To set up BBMDs using the BBMD Configuration Tool 

If your system has multiple routers that reside on different IP subnets, you must set up one router on each IP 

subnet as a BACnet/IP Broadcast Management Device (BBMD).  

Every subnet with a router must have a BBMD configured in order for broadcasts from routers on that subnet to 

reach the rest of the routers on the network. 

NOTES 

• The i-Vu® Standard or Plus application - If the i-Vu® web server is on a separate subnet than the rest of the 

routers, the internal router must be assigned a routable IP address and configured as a BBMD. 

• The i-Vu® Pro application - If the i-Vu® Pro server is on a separate subnet than the rest of the routers, you 

must register it as a foreign device to a router acting as a BBMD device. 

 

Use the BBMD Configuration Tool to: 

• Write/read the Broadcast Distribution Table (BDT) of each BBMD device 

• Allow controllers on one subnet to communicate with controllers on other subnets  

• Enable the i-Vu® application to see, upload, or configure controllers on different subnets 

To set up BBMDs using the BBMD Configuration Tool 

1 Assign an IP address, subnet mask, and default gateway for each Carrier router on the IP network. See 

Addressing the i-Vu® XT or TruVu™.  

2 Acquire the BBMD Configuration Tool from the Tech Tools USB drive or from the Carrier Control Systems 

Support Site http://www.hvacpartners.com/, https://accounts.ivusystems.com/. This is a stand-alone 

executable file and no installation is necessary.  

3 Create a BBMD table. See above. 

 CAUTIONS 

○ Define only one BBMD per subnet. Multiple BBMDs on an IP subnet disrupt network communications.  

○ Unless explicitly modified, the UDP Port for BACnet/IP is 0xBAC0 (47808). Do not change this parameter 

unless you made a change in the router. 

4 Open the BBMD Configuration Tool.  

5 In the IP Address or Host Name field, type the IP address of the router that functions as the BBMD (BACnet 

Broadcast Management Device) for its subnet.  

6 To check if the router has an existing BBMD table, click the Broadcast Distribution Table Read button. 

7 If the Broadcast Distribution Table contains IP addresses that are not in your file, verify that they are valid 

BBMDs and, if so, add them to your file.  

NOTES 

○ The BDT's in each BBMD should be identical. Repeat this entire process whenever a BBMD is added. 

○ If needed, disable the checkbox next to Show Broadcast to limit the amount of scrolling text that is 

displayed.  

8 Click the Broadcast Distribution Table Browse button and select the file that you made in step 4.  

9 Verify that the appropriate IP address is still in the IP Address or Host Name field.  

10 Click the Broadcast Distribution Table Write button.  

11 Click Read again to verify that the new file was written to the router. See example below. 

http://www.hvacpartners.com/
https://accounts.ivusystems.com/
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NOTE If you have a large BDT, you may have to re-size the BBMD Configuration Tool window to see the 

Broadcast Distribution Table.  

 

 

12 Using the next IP address in the file, repeat steps 5 through 10 until every file has been updated.  

NOTE To clear the BBMD entries from a router, follow the steps above using an empty (blank) file. A cleared 

BBMD table contains just the router’s IP address without entries in the BBMD table, as shown below. 
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13 Acquire the BBMD Configuration Tool from the Tech Tools USB drive or from either of the Carrier Control 

Systems Support Sites http://www.hvacpartners.com/, https://accounts.ivusystems.com/. This is a stand-

alone executable file and no installation is necessary.  

14 Make a list of the IP addresses for each router that will function as a BBMD in your system.  

In the above illustration, the Carrier router, address 172.18.1.2, must be configured as a BBMD for the 

172.18 subnet, while the Carrier router, address 172.16.1.15, must be configured as a BBMD for the 

172.16 subnet.   

 CAUTIONS 

○ Define only one BBMD per subnet. Multiple BBMDs on an IP subnet disrupt network communications.  

○ Unless explicitly modified, the UDP Port for BACnet/IP is 0xBAC0 (47808). Do not change this parameter 

unless you made a change in the router. 

15 In a text editor such as Notepad, create a list of the routers that will be BBMDs. List each IP address on a 

separate line. (Maximum of 50 IP addresses per file)  

 

 

16 Save the file to your folder of choice with a .bdt, .bbmd, or .text extension instead of .txt.  

17 Open the BBMD Configuration Tool.  

18 In the IP Address or Host Name field, type the IP address of the router that functions as the BBMD (BACnet 

Broadcast Management Device) for its subnet.  

19 To check if the router has an existing BBMD table, click the Broadcast Distribution Table Read button. 

20 If the Broadcast Distribution Table contains IP addresses that are not in your file, verify that they are valid 

BBMDs and, if so, add them to your file.  

NOTES 

○ The BDTs in each BBMD should be identical. Repeat this entire process whenever a BBMD is added. 

○ If needed, disable the checkbox next to Show Broadcast to limit the amount of scrolling text that is 

displayed.  

21 Click the Broadcast Distribution Table Browse button and select the file that you made in step 4.  

22 Verify that the appropriate IP address is still in the IP Address or Host Name field.  

23 Click the Broadcast Distribution Table Write button.  

 

 

 

 

 

 

 

http://www.hvacpartners.com/
https://accounts.ivusystems.com/
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24 Click Read again to verify that the new file was written to the router. See example below. 

NOTE If you have a large BDT, you may have to re-size the BBMD Configuration Tool window to see the 

Broadcast Distribution Table.  

 

 

25 Using the next IP address in the file, repeat steps 7 through 14 until every file has been updated.  

NOTE To clear the BBMD entries from a router, follow the steps above using an empty (blank) file. A cleared 

BBMD table contains just the router’s IP address without entries in the BBMD table, as shown below. 
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Important changes to this document are listed below. Minor changes such as typographical or formatting errors are not 

listed. 

  

 Date Topic Change description Code* 

1/31/22 

 

To set up BBMDs using the BBMD 

Configuration Tool 

Added .bbmd and .text as allowable file extensions, removed .bdt-

specific instructions 

X-TS-OC-O 

To create and download a BBMD table 

Create a control program in Snap Added Display microblocks and updated the procedure. C-TS-JN-O 

Connect the third-party device to the 

Carrier controller  

To connect to a BACnet/IP device 

Added ports Eth0 and Eth X-D 

Configure Display Microblocks New topic C-TS-JN-O 

4/6/20 Overview Added list of all controllers that can be integrated with a BACnet 

device 

C-PM-KC-O 

Appendix A - Configuring the driver 

parameters by using the Service Port 

Added instructions for the TVMPCXP1628-NR. 

Added Autobaud. 

To wire to a BACnet MS/TP network Changed first paragraph to include comments about the TV-

MPCXP1628-NR. 

Before-you-begin checklist Added autobaud  

1  Connect the third-party device to the 

Carrier controller 

Added note regarding TV-MPCXP1628-NR 

  

*  For internal use only 
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